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Chapter 32: Lyrics Tool

Lyrics Tool 
What it does
This tool lets you create, edit, and move lyrics in your score. You can create many different sets of 
lyrics (which you might use, for example, in a hymn with several verses); you can move the base-
line (the imaginary line upon which the bottoms of the words align) up or down independently for 
each set of lyrics. When you click this tool, the Lyrics Menu appears; it contains all the commands 
you need to create lyrics in your score. See LYRICS for more information.

Special mouse clicks
• Click a staff to tell Finale the staff to which you want lyrics attached.
• In Type Into Score, use ↑  or ↓  to move to the previous or next verse, chorus or section.
• In Type Into Score mode or Click Assignment mode, drag the positioning triangles at the 

left edge of the screen to specify the vertical position of the baseline for the lyric set you’re 
inserting. For a full discussion of these triangles and their functions, see LYRICS.

• In Type Into Score mode, click near the first note to indicate which note you want to attach 
a syllable to. Then type the lyrics normally.

• In Type Into Score mode, click near a note to select (highlight) the syllable attached to it. 
Anything you now type replaces the highlighted syllable.

• In Click Assignment mode, click near the first note to attach the first syllable in the scroll-
ing window. (If the note is in Voice 2, shift-click.)

• In Click Assignment mode, ctrl-click near the first note to tell Finale to assign all syllables 
in the lyric set displayed in the scrolling window. Finale attaches one syllable at a time to sub-
sequent notes in the melody, automatically skipping over rests and tied notes. (Finale only 
assigns lyrics to the notes in the current layer, as identified by the pressed Layer push button in 
the lower-left corner of the window.)

• In Edit Word Extensions mode, click near the sustained syllable to display a handle at the 
end of the syllable. (If the note is in Voice 2, shift-click.) Drag this handle to the right to draw 
a word extension underline (indicating that the syllable is sustained through more than one 
note). Click this handle and press delete to remove the word extension.

• In Adjust Syllables mode, click near the syllable you want to move to display handles on 
that syllable and any others attached to the same note. (If the syllable is assigned to a note in 
Voice 2, shift-click.) Drag a lower handle to move the syllable; select it and press backspace to 
restore it to its original position; select it and press delete to remove it from the score. Select 
several vertically-aligned handles (by shift-clicking, drag-enclosing or using ctrl-A) and 
choose alignment and justification options from the Alignment and Justification submenus. 
See LYRICS MENU–ALIGNMENT AND JUSTIFICATION, below.
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• In Clone Lyric mode, click one measure, shift-click another measure, drag-enclose sev-
eral measures, or click to the left of the staff to select one measure, additional measures, a 
group of measures, or the entire staff at once. Drag the first selected measure so that it’s super-
imposed on the first target measure to copy the lyrics from the selected measures to the target 
measures.

• In Shift Lyrics mode, click near the first syllable you want shifted to shift that syllable and 
subsequent syllables one note to the right or left (automatically skipping rests and tied notes).

Contextual menus
Contextual menus are reached by right mouse-clicking the handle closest to the note. A contextual 
menu will be displayed where you can select various items.

Lyrics Menu
How to get there

Click the Lyrics Tool k.

What it does
The Lyrics Menu contains all the commands you’ll need to create and edit lyrics, distribute the 
text in the score, adjust the positions of individual syllables, draw word extensions for syllables 
that are sustained, and so on.

You can have as many sets of lyrics as you want—up to 512 of each of Finale’s three lyric types: 
Verse, Chorus, and Section. There’s no technical distinction between these three types—the lyrics 
you enter as a Verse can be used in the chorus of your song, and vice versa. They’re only there to 
help you keep your lyrics straight, and to make it easy to change the font or style for a large chunk 

Lyrics handles

Menu item What it does

Align Default Changes the alignment of the syllables back to Finale’s global set-
ting

Align Center Changes the alignment of the syllables to centered under the note

Align Left Changes the alignment of the syllables to the left under the note

Align Right Changes the alignment of the syllables to the right under the note

Justify Default Changes the justification of the syllables back to Finale’s global 
setting

Justify Center Changes the justification of the syllables to centered relative to 
each other

Justify Left Changes the justification of the syllables to the left relative to each 
other

Justify Right Changes the justification of the syllables to the right relative to 
each other
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of lyrics at once (you can specify a different font for Verses, Choruses, and Sections by choosing 
Select Default Fonts from the Options Menu).

• Edit Lyrics. Choose this command to enter Finale’s text processor. If you have copied lyrics 
from an external word processor, press ctrl-V here to paste them. Otherwise, you can create 
lyrics from scratch; just type them in, being sure to insert a hyphen between syllables. (Finale 
recognizes a space, hyphen, or carriage return as the end of a syllable.) For a full description 
of the Edit Lyrics window, see EDIT LYRICS WINDOW.

• Adjust Syllables. This command lets you move an individual syllable anywhere you want it. 
Click the staff above a syllable; two handles appear. Click a handle to select its syllable; shift-
click to select additional syllables attached to the same note. Drag a lower handle to move its 
syllable (or all selected syllables) to a new position; press backspace to restore a selected syl-
lable to its original position. To remove a selected syllable (or all selected syllables) from the 
score, press delete. You can also use Adjust Syllables in conjunction with the alignment and 
justification commands (see below). Click the upper handle to set alignment and justification.

• Click Assignment. After you’ve typed lyrics into the Edit Lyrics window, choose Click 
Assignment from the Lyrics Menu. The scrolling Click Assignment window appears; click the 
staff to which you want to add lyrics (move the Click Assignment window out of the way, if 
necessary, by dragging its title bar). A syllable from the left end of this window attaches itself 
to each note you click (or, if the note is in Voice 2, each one you shift-click). 

If you ctrl-click a note, however, Finale will zip through your entire set of lyrics, intelligently 
distributing them to the notes in the score skipping rests and tied notes, as well as notes in dif-
ferent layers and voice two, for as many notes as there are syllables. (Click Assignment will 
stop at default whole rests.) See CLICK ASSIGNMENT DIALOG BOX for a more complete discus-
sion.
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• Clone Lyric. Use this command when you want to copy the lyrics from one staff (the “source” 
staff) to another (the “target” staff). This technique, however, only copies one set of lyrics at a 
time—either the Verse, Chorus, or Section currently specified by the Specify Current Lyric 
command, or the last lyric you edited.

After choosing this command, select the measures containing the source lyrics by clicking, 
shift-clicking, the same techniques you use with the Mass Mover Tool.

Once the source measures are selected, drag the first selected measure so that it’s superim-
posed on the first target measure. (If the target measure isn’t visible in the same screen, scroll 
so that you can see it, then ctrl–shift-click it.) Finale will copy the lyrics from the source mea-
sures to the target measures. Bear in mind that only notes that fall on the same beats as those 
in the source measures will receive syllables. (Note, too, that the vertical positions of the base-
line-positioning triangles will be the same in the target staff as they were in the source staff.)

• Edit Word Extensions. A Word Extension is the underline following a syllable sustained 
beyond the note to which it’s attached.

To create a Word Extension, choose the command from the Lyrics Menu, then click in the staff 
above the syllable in question. A square handle appears. Drag it to the right as far as you want 
to draw the Word Extension underline. To remove the Word Extension, click its handle and 
press Delete.

See also WORD EXTENSIONS and WORD EXTENSIONS (REMOVE) plug-ins.

• Shift Lyrics. When you choose this command, Finale displays the Shift Lyrics dialog box, 
where you can specify the direction in which you want all the syllables shifted. See SHIFT 
LYRICS DIALOG BOX for a more detailed description.

• Type Into Score. Instead of typing lyrics into the Edit Lyrics window separately, you can 
enter them directly into the music, so you always know where you are relative to the melody. 
To do so, first specify the lyric type and number for the lyrics you intend to create (by choos-
ing Specify Current Lyric from the Lyrics Menu). Finale will automatically select Type into 
Score mode when you click the Lyrics Tool or exit Click Assignment. To return to Type into 
Score after other lyric editing, such as Shift Lyrics or Word Extensions, choose Type Into 
Score from the Lyrics Menu.

• Alignment: Default • Align Left • Align Right • Align Center; Justification: Default • Jus-
tify Left • Justify Right • Justify Center. These commands, only available when Adjust Syl-
lables is selected in the menu, are similar to the alignment and justification option in the Text 
tool. They allow you to easily set the horizontal position of your lyrics on a syllable by sylla-
ble basis. These commands are useful when you want all the syllables (in several verses) 
beneath a particular note neatly aligned. You might use this feature to left-justify a specific 
syllable of each verse under the first note of a hymn, for example. For global settings see the 
LYRIC OPTIONS DIALOG BOX.
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Set the alignment and justification by selecting it from the menu, or using the keyboard short-
cuts listed in the menu. The handle will move from one side of the syllable to the other 
depending on which type of justification you have selected.

• Specify Current Lyric. Choose this command to display the Specify Current Lyric dialog 
box, where you can specify which Verse, Chorus, or Section you want to edit, Type Into Score, 
clone, or Click-Assign. (See SPECIFY CURRENT LYRIC DIALOG BOX.)

• Adjust Baselines. This command displays the Adjust Baselines dialog box, where you can 
specify the exact vertical location for the baseline of each lyric type and number (the invisible 
line against which the bottoms of the words align). For a more complete discussion, see 
ADJUST BASELINES DIALOG BOX.

• Lyric Options. Choose this command to display the Lyric Options dialog box.  In this dialog 
box you can specify alignment, spacing and line thickness options. See LYRIC OPTIONS DIA-

LOG BOX.

Edit Lyrics window
How to get there

Click the Lyrics Tool k, and choose Edit Lyrics from the Lyrics Menu.

What it does
The Edit Lyrics window is one of the two ways you can enter lyrics (the other way is to use the 
Type Into Score feature; see LYRICS MENU). Within this window, you can also create variations in 
the main font (which you’ve specified with the Select Default Fonts command in the Options 
Menu)—for example, you can italicize a phrase within the lyrics. If you’ve copied lyrics from an 
external word processor, you can paste them directly into the Edit Lyrics window by pressing ctrl-
V.

 The Edit and Text menus are available when the window appears so you can copy and paste text, 
change fonts and styles, and carry out other editing tasks. Note that only the Text Menu com-
mands that affect the display of text characters are available for lyrics; the Line Spacing and Edit 
Page Offset commands as well as the commands in the Inserts and Justification submenus are not 
available. 
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Once you’ve put these lyrics into the score by using the Click Assignment command, the lyrics in 
the score are dynamically linked to the lyrics in the Edit Lyrics Window. Change a word in the 
Edit Lyrics window and it’s also changed in the score; delete it, and all the syllables in the score 
slide to the left to close up the gap. (Bear in mind that the same process works in reverse when you 
use the Type Into Score feature to edit your lyrics in the score: any word deleted from the score is 
also deleted from the Edit Lyrics window—but not when you erase lyrics from the score using the 
Mass Mover or the Adjust Syllables feature. In those cases, you’re just removing lyrics from the 
score, but they remain in the Edit Lyrics window.)
You can cut, copy, and paste lyrics from one place to another within a single screenful of Edit Lyr-
ics lyrics, as well as from one set of lyrics to another. To cut or copy, select the text by dragging 
the cursor through it. Then press ctrl-X to cut it (and place a copy on the Clipboard) or ctrl-C to 
copy it. To paste the cut or copied text, click at the location where you want the lyrics to appear 
and press ctrl-V.

• Lyric: Verse • Chorus • Section • ___. Use this drop-down list to choose what type of lyric 
you want to create or edit. Enter the verse number, or use the up and down arrows to switch to 
different verses, choruses or sections.
The three types of lyrics (Verse, Chorus, and Section) are technically identical as far as Finale 
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is concerned. They’re only there to help you keep your lyrics straight, and to make it easy to 
change the font or style for a large chunk of lyrics at once (you can specify a different font for 
Verses, Choruses, and Sections by choosing Select Default Fonts from the Options Menu).

• OK • Cancel. Click OK (or press enter) if you want Finale to store the lyrics or modifications 
you’ve created, and assign a number to any new sets you entered. You return to the score. 
Click Cancel if you want Finale to ignore any text you’ve entered or changes you’ve made 
while in the Edit Lyrics window. You return to the score.

Click Assignment dialog box
How to get there

Click the Lyrics Tool k. After creating lyrics with the Edit Lyrics command in the Lyrics 

Menu, choose Click Assignment from the Lyrics Menu (and then click the note to which you want 
to begin attaching lyric syllables). (If you’ve created different lyrics types—Verse, Chorus, and 
Section—the Click Assignment window will display only the most recent lyric type you’ve 
worked on. Use the Specify Current Lyric command in the Lyrics Menu to specify a different 
type.)

What it does
The Click Assignment window provides a scrolling display of any lyrics you entered in the Edit 
Lyrics text processor. Use the lower scroll bar to scroll through the lyrics horizontally (click in the 
gray area to move one full window to the left or right, and click the arrows to move one syllable at 
a time). If you entered several sets of lyrics (more than one Verse, Chorus, or Section, for exam-
ple), use the upper scroll bar to scroll through different sets of the same type. You can move the 
Click Assignment window by dragging its title bar, and you can close it (and exit the Click 
Assignment mode) by clicking its close box.

When this window is present, each time you click a note in the score, the lyric at the left edge of 
the Click Assignment window disappears from the window and attaches itself to the note you 
clicked. (Your clicks need to be within the staff lines, not necessarily on the noteheads.) If you 
click within the staff at the position of a note while pressing ctrl, Finale will automatically distrib-
ute all the syllables in the Click Assignment window to the notes in the score, until it runs out of 
either notes or syllables.

• Auto Update. If you’re assigning syllables to notes in the score by clicking one note at a time, 
you can select the Auto Update button to make Finale redraw the measure after you assign 
each syllable, widening it if necessary to accommodate the lyrics. (If you don’t select Auto 
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Update, the lyrics may overlap slightly as you’re putting them into the score. To space them 
correctly, use the Music Spacing command, as described in MUSIC SPACING.)

• [Four positioning triangles]. When the Click Assignment window appears, four triangles 
also appear, at the left edge of the screen. These triangles are handles that control the baseline 
for the lyrics (the invisible line against which the bottoms of the letters align).

Dragging the leftmost triangle up or down moves the baseline for this set of lyrics vertically, 
affecting the entire piece. The second triangle sets the baseline for this set of lyrics for this 
staff only. The third triangle, whose effect is only visible in Page View, sets the baseline for 
this staff in this system only (which can be useful if, for example, you have a vocal passage of 
very low notes requiring that the lyrics be moved down a little bit to make room). The right-
most triangle sets the baseline for the next syllable you assign if you’re “clicking in” one syl-
lable at a time or for the next syllable you enter using Type Into Score.

Shift Lyrics dialog box
How to get there

Click the Lyrics Tool k. Choose Shift Lyrics from the Lyrics Menu.

What it does
When you’re working with lyrics, you may occasionally need to push all the syllables in the music 
to the right or left by one note. For example, suppose you enter the lyrics in the Edit Lyrics win-
dow but forget to anticipate a melismatic passage (where one syllable is sustained over several 
melody notes) in the melody. When you use the Click Assignment feature to place the lyrics into 
the score, Finale will assign a syllable to each note of the melisma, and no subsequent syllables 
will align with their correct notes for the rest of the melody. You can use the Shift Lyrics feature to 
shift all the syllables simultaneously so that they’re aligned with the correct melody notes.

In this dialog box, you have several options for shifting the lyric syllables. You can specify that 
you want them shifted forward, backward, all the way to the beginning (or ending) of the score, or 
only as far as the next melody note without a syllable.
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• Shift Lyrics to the Left • Right. From the drop-down list, choose the direction in which you 
want Finale to slide the lyric syllables, relative to the notes. 
If you choose Left, then when you return to the score, click within the staff lines at the posi-
tion of the note just to the left of the first syllable you want moved; Finale will move that syl-
lable (and subsequent syllables) to the left by one melody note, automatically skipping over 
rests and tied notes. Click again (in the staff lines at the position of the note just before the first 
syllable) for each additional one-note shift. 
If you choose Right, click within the staff lines at the position of first syllable you want 
moved; Finale will push that syllable (and subsequent syllables) to the right by one melody 
note, automatically skipping over rests and tied notes. Click again (in the staff lines above the 
first syllable) or each additional one-note shift.

• Shift Syllables by One Note, to the End of the Lyric • Shift Syllables by One Note, to the 
Next Open Note. Finale needs to know what range of syllables you want it to shift. If you 
click the first option, Finale will slide every syllable (from the one you click) all the way to the 
end of the lyric. (See SPECIFY CURRENT LYRIC DIALOG BOX for a full description of Finale’s 
three lyric types.) 
If you click the second option, Finale will only shift syllables from the one you click through 
the next note that has no syllable attached to it.

• Rotate Syllables. This option is only useful if you’ve created a set of lyrics with more sylla-
bles than there are notes to attach them to. Select this option on those rare occasions when you 
want to replace the syllable on each note with the syllable to its right or left—but without 
changing which notes have lyrics.

• OK • Cancel. Click OK (or press enter) to return to the score. If you selected To The Right, 
click in the staff above the first syllable you want to shift to the right. If you selected To The 
Left, click in the staff at the position of the note just before the first syllable you want shifted 
to the left. Click Cancel to return to the score. Finale won’t shift any lyrics if you click the 
staff.
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Specify Current Lyric dialog box
How to get there

Click the Lyrics Tool k. Choose Specify Current Lyric from the Lyrics Menu.

What it does
Your lyrics can include up to 512 of each of Finale’s three lyric types: Verse, Chorus, and Section. 
There’s no technical distinction between these three types—the lyrics you enter as a Verse can be 
used in the chorus of your song, and vice versa. They’re only there to help you keep track of your 
lyrics, and to make it easy to change the font or style for a large chunk of lyrics at once (you can 
specify different fonts for Verses, Choruses, and Sections, by choosing Select Default Fonts from 
the Options Menu).

In this dialog box, you can specify the lyric type you want to edit (in the Edit Lyrics window), 
insert into the score (using the Click Assignment or Type Into Score commands), or copy (using 
the Clone command). In the text box, you can also specify by number which Verse, Chorus, or 
Section you want to edit.

 

• Verse • Chorus • Section. Click the radio button corresponding to the lyric type you want to 
select.

• Number. The number in this text box identifies the specific Verse, Chorus, or Section that’s 
currently selected.

• OK • Cancel. Click OK (or press enter) to return to the score. Now you’re ready to edit, type 
(with Type Into Score), or “click-assign” the lyric you specified. Click Cancel to return to the 
score without changing the lyric type or number.

Adjust Baselines dialog box
How to get there

Click the Lyrics Tool k. Choose Adjust Baselines from the Lyrics Menu.

What it does
In this dialog box, you can specify the exact position of the baseline of each lyric type and number 
(the invisible line against which the bottoms of the words align) in relation to the staff. Further-
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more, you can specify a different baseline position (marked by the four positioning triangles in 
Click Assignment mode) for each staff. The numbers in these boxes are measured from the middle 
line of the staff using the currently selected measurement units (Options Menu). Lower values 
(that is, larger negative values) move the baseline down.

You’ll usually want the baseline of Verse 1, for example, to be just below the melody, and Verse 2 
to be just under Verse 1. As a matter of fact, Finale’s default values position verses in precisely 
that way: one beneath another. If you change the font for your Verses (by choosing Select Default 
Fonts from the Options Menu) and find you have overlapping lyric due to the font size, you can 
neatly adjust the baselines for all lyric lines at once by clicking the Set Piece Offsets to Default 
Font button.

Note, by the way, you can perform these same settings visually by dragging any of the four posi-
tioning triangles up or down when you’re in Click Assignment or Type Into Score mode. This dia-
log box, however, provides a way to preset the lyric lines’ positions, to specify very precise 
numerical locations, or to adjust several at once (even after the lyrics have been entered).

• Verse • Chorus • Section. Select the appropriate radio button for the lyric type whose base-
line positions you wish to edit.

• Number. In this text box, enter the Verse, Chorus, or Section number for which you’re setting 
the baseline positions.

• Piece. The number in this text box specifies the position for all the lyrics of the indicated type 
and number. It corresponds to the position of the first (leftmost) positioning triangle (of the 
four that appear when you’re placing lyrics in the score using the Click Assignment or Type 
Into Score commands). This number is measured from the middle line of the staff; since the 
default position is below the middle line, the number is a negative number.
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• Staff (#) • Prev • Next. Sometimes, even after you’ve specified the Piece Offset (see above), 
the lyrics in one particular staff may need a slightly different placement—for example, if the 
notes in the alto line fall mostly below the staff, the lyrics may need to be moved lower. In the 
Staff Offset text box, you can specify a new vertical position for the lyrics only in the indi-
cated staff. (This setting corresponds to the positioning of the second of the four positioning 
triangles.) The Staff: indicator identifies the staff by name, if you’ve named it, or by number; 
cycle through the staves in your piece by clicking the Prev and Next buttons to its right. 

When the Staff: indicator identifies the staff whose lyric line position you need to change, 
enter a number in the text box. This number indicates how much higher or lower the lyric line 
should be in this staff compared to other staves in the piece—in other words, how much higher 
or lower it should be than the Piece Offset baseline position. A larger negative number moves 
the lyric line farther down.

• Staff System (#) • Prev • Next. Not only can you specify a separate lyric line position for 
each staff (above), but you can even specify the position of the baseline in an individual sys-
tem. If, for example, the notes in a staff are so low that they threaten to overlap the lyrics—but 
only in a measure or two—use this setting to move the lyric line out of the way only for the 
affected staff and system. (This setting corresponds to the positioning of the third of the four 
positioning triangles.)

The Staff System: indicator identifies the system by number. Click the Prev and Next buttons 
to its right to specify the system number. Set the staff number with the Staff: Prev and Next 
buttons (see above). 

When the Staff and Staff System indicators identify the line whose lyric position you want to 
change, enter a number in the text box. This number, indicates how much higher or lower the 
lyric line should be in this system compared to other systems (for this staff)—in other words, 
how much higher or lower it should be than the Staff Offset baseline position. A larger nega-
tive number moves the lyric line farther down.

• Total Offset. This indicator displays the final position for the indicated lyric type, number, 
staff, and system, as measured from the middle line of the staff. Finale arrives at this figure by 
adding the Staff and Staff System values to the basic Piece Offset.

• Set Piece Offsets To Default Font. Click this button to tell Finale to automatically change the 
baseline-positioning values for all Verses, Choruses, and Sections in all staves. When this is 
done, each successive lyric of each type is neatly and evenly stacked. When Finale calculates 
these default positions, it takes into account the font and size you’ve specified by choosing 
Select Default Fonts from the Options Menu and clicking Verse, Chorus, or Section.

You might click this button, for example, if you’ve just chosen a font for your verses that’s 
smaller than usual; Finale will respond by moving all the Verse lyric lines closer together 
(than they were when a larger font was selected). Or suppose you’ve been experimenting with 
the positioning triangles, but you can’t get them back to their evenly-spaced default positions; 
click this button, and Finale will restore them.
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• OK • Cancel. Click OK (or press enter) to confirm the settings you’ve made in this dialog box 
and return to the score, where you’ll see the effects of your lyric line positioning (if you’ve 
already added lyrics). Click Cancel to tell Finale to ignore any changes you made in this dia-
log box. You return to the score.

To further adjust the position of a lyric line, directly in the score see To set the baseline (verti-
cal position) for lyrics graphically.

Lyric Options dialog box
How to get there

Click the Lyrics Tool k. Choose Lyric Options from the Lyrics Menu.

What it does
In this dialog box, you can specify the alignment and justification of specific types of syllables in 
your piece such as syllables with word extensions, or syllables starting a system. You can also set 
the hyphen spacing, word extension line thickness and the position of word extensions (vertically 
and horizontally).
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• Syllables with Word Extensions • First Syllable in Lyric • Syllables at Start of System • 
Others; Alignment • Justification: Center • Left • Right. You can select the global align-
ment and justification option for your score with these settings. (See LYRICS MENU for exam-
ples of syllable alignment and justification.) The order of the alignment and justification items 
in the dialog box also indicate order of precedence. For example, if you have a syllable which 
is the first syllable in the system, but also has a word extension, the Syllables with Word 
Extensions settings will be used instead of the Syllables at Start of System (assuming you 
have both these items checked). If you have a syllable that starts a system as well as has a 
word extension, the setting for word extensions will be used. Select the checkbox next to the 
options you would like to affect your score.

• Lift • Push. The numbers in these two text boxes affect lyric syllable extension lines, or word 
extensions—the underline drawn after a syllable that’s sustained through more than one note. 
Lift refers to the vertical distance between the baseline of the lyrics and the underline itself. 
Push refers to the amount of horizontal space between the end of the syllable and the begin-
ning of the underline. (The default value for both parameters is 0.014 inches.) 

• Line Thickness. This option sets the line thickness for word extensions in your score. Enter a 
value for the line thickness.

• Space Between Hyphens. Enter the distance between multiple hyphens that appear between 
lyric syllables. When the distance between hyphens matches this value, Finale creates another 
hyphen between the lyric syllables. If you only want a single hyphen to appear between sylla-
bles, set this value to a large distance, such as 12 inches.

• OK • Cancel. Click OK (or press enter) to confirm the settings you’ve made in this dialog box 
and return to the score, where you’ll see the effects of your settings. Click Cancel to tell Finale 
to ignore any changes you made in this dialog box. You return to the score.

Clear Lyric Positioning Plug-in
How to get there

Select Clear Lyric Positioning from the Plug-ins Menu.

What it does
The Clear Lyric Positioning plug-in allows you to clear any individual positioning of lyrics base-
lines for the selected lyrics.
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• Choose the lyric section(s) to reset [list box]. Select the lyric sections to be reset here.

• Horizontal • Vertical. Select the checkboxes to reset only vertical changes, horizontal 
changes or both.

• OK • Cancel. Click OK to make the selected changes. Click Cancel to return to the score 
without making any changes.

Extract Lyrics Plug-in
How to get there

From the Plug-ins Menu, choose Lyrics, then select Extract Lyrics.

What it does
The Extract Lyrics plug-in allows you to save the lyrics in your file to a text file. These lyrics 
could then be imported into a word processor for spell-checking or sent to a lyricist for collabora-
tions. You may choose to extract all lyrics, all lyrics of a specified type, or any single lyric of a 
specified type.
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• All Lyrics • Verse/Chorus/Section Number • All Verses/Choruses/Sections. Choose which 
lyric or lyrics to extract from the current score. When Verse Number, Chorus Number or Sec-
tion Number is chosen, the text box and arrow items become enabled. Use the up or down 
arrow keys to change the selected number or type directly into the box.

• Remove Hyphens. When this checkbox is selected, the extraction process will strip normal 
hyphens out of the text before saving it to the text file.

• Include Labels. When this checkbox is selected, the plug-in will add a label for each lyric of 
each type to be extracted. The label will appear on a line by itself in the following form:

Verse_Lyric: 1

The digit indicates the number of the lyric which has been extracted.

• Linebreaks After Sentence End. When checked, this feature will add linebreaks after punc-
tuation marks, such as periods, question marks, and semi-colons. If you have already format-
ted your lyrics in the Edit Lyrics dialog box, you may wish to leave this option unchecked.

• Info • Extract • Close. Click Info for more information about the author of this plug-in. Click 
Extract to extract the lyrics to a text file. Finale will prompt for a name and folder to save the 
resulting text file. Click Close to return to the score without making any changes.

Word Extensions Plug-in
How to get there

Select Word Extensions from the Plug-ins Menu. If you prefer to apply Automatic Word Exten-

sions to a specific region, select the region using the Mass Mover Tool before selecting the plug-in 

from the Plug-ins Menu. See PLUG-INS MENU for more information on plug-ins.



Word Extensions (Remove) Plug-in 32-17      

OC

OC

ndex

Index

ext 
hapter

ext 
hapter

revious
hapter

revious
hapter
T

T

I

N
C

N
C

P
C

P
C

What it does
The Word Extensions plug-in allows you to easily add word extensions to your lyrics. Word 
Extensions will add a melisma to a syllable from the end of the syllable until the note before the 
next syllable, even across systems. See also WORD EXTENSIONS (REMOVE) PLUG-IN.

Word Extensions (Remove) Plug-in
How to get there

Select Word Extensions (Remove) from the Plug-ins Menu. If there is no Mass Mover Selection 

when you invoke the Word Extensions (Remove) plug-in, it will ask you if you want to process the 
entire document. See PLUG-INS MENU for more information on plug-ins.

What it does
The Word Extensions (Remove) plug-in is used to remove all word extensions from Lyrics in the 
selected region.
Use the Mass Mover Tool to select a region from which you wish to remove all word extensions 

from the Lyrics, then choose the Word Extensions (Remove) command from the Plug-ins Menu. 

The plug-in will look for any word extensions in the selected region and remove them. See also 
WORD EXTENSIONS PLUG-IN.

Lyrics
There are two ways to create lyrics within Finale. You can type the lyrics directly into the score, so 
that you know at all times where you are in the music—a feature called Type Into Score. Or you 
may prefer the faster Click Assignment method—where you type the lyrics in Finale’s text pro-
cessor (called the Edit Lyrics window), and then paste them into the score all at once. The Click 
Assignment method also offers you the option of pasting your lyrics in from another program, 
such as a word processor; see IMPORTING.
Finale defines a syllable as any letters separated by a space or a hyphen. When you put the lyrics 
into the score, Finale places the syllable in your score by the settings in the Lyrics Options dialog 
box, centers the hyphen between notes, and moves any syllable correspondingly if its notehead 
moves.
Lyrics are often written in distinct sections—verse and chorus, for example. For that reason, 
Finale provides three different lyric types—Verse, Chorus, and Section. These types are identical 
in every respect—you can write the verse of a song and define it as a Chorus, if you want to—
except that you can set the default font and positioning for each type differently. You could spec-
ify, for example, that all Verses are to be set in boldface type, but that all Choruses are set in italic 
type. (You can have as many as 512 of each lyric type. You can also change the font and style 
within any lyric.)
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To type lyrics directly into the score

• Click the Lyrics Tool k. The Lyric Menu appears. If you want to specify a lyric type 

(Verse, Chorus, or Section), choose Specify Current Lyric from the Lyric Menu. If you don’t 
specify a type, your first lyrics will be a Verse.

• If you’re returning from other lyric editing, choose Type Into Score from the Lyric 
Menu.

• Indicate the staff and the note to which you want to begin adding lyrics by clicking near 
the staff at the position of the first melody note. A set of four positioning triangles appears 
at the left edge of the screen. The triangles control the baseline of the lyrics (against which the 
bottom edges of the words line up). For a full discussion, see “To set the baseline (vertical 
position) for lyrics graphically,” below. The blinking cursor—the insertion point—jumps to a 
position beneath the first note, in the staff you clicked.

• Type the lyrics. Each time you type a space or a hyphen, Finale automatically moves the 
insertion point in preparation for entering the next syllable. As you type, Finale automatically 
scrolls the music so you always know where you are. 

If you make a mistake, just backspace over it by pressing backspace. (If you backspace to the 
previous syllable, Finale highlights the whole syllable so that you can replace it all at once 
with anything you type.) To change a word you’ve already typed, click in the staff so that the 
syllable is highlighted, and then type its replacement.

If you encounter a melismatic passage, where one syllable is sustained through several melody 
notes, press the space bar for each note of the melisma; the cursor will skip ahead to the next 
note. When you reach the last note in the piece, press the space bar one more time and Finale 
will give you the option to return to the beginning of the document to start a new lyric under-
neath the previous one.

As you type, Finale stores each syllable in its built-in text processor, the Edit Lyrics window. 
It’s important to understand that the Edit Lyrics window and the lyrics in the score are dynam-
ically linked. If you change a syllable in the Edit Lyrics window, every occurrence of the syl-
lable is automatically changed in the score—and vice versa.
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Important: When you enter lyrics using this method, pay special attention when entering addi-
tional lyric lines, one beneath another. To add a new lyric line, be sure to change Verses before 
typing in each new line; to do so, choose Specify Current Lyric from the Lyric Menu. Other-
wise, Finale will believe that all the lyrics, even successive lines, are all part of the same 
“verse,” and unexpected results may occur.
Hint: if you want a quick MIDI audio check of the notes you’re attaching lyrics to, hold down 
ctrl and the space bar and drag the cursor across the staff. Finale will play any note the cursor 
touches, no matter which direction you drag.

To prepare lyrics in a separate window
This is the first step to adding lyrics to the score using the Click Assignment method.

• Click the Lyrics Tool k. The Lyrics Menu appears.

• Choose Edit Lyrics from the Lyrics Menu. The Edit Lyrics window appears.
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• Type the lyrics, including hyphens within polysyllabic words. If you’ve copied lyrics from 
another program (such as a word processor), press ctrl-V (for Paste). If you make a mistake, 
backspace over it with the backspace key. If you’re anticipating a melisma (one syllable held 
over several notes), type alt+0160 and a regular space for each extra note through which the 
syllable is held.
You can cut (by pressing ctrl-X), copy (by pressing ctrl-C), or paste (by pressing ctrl-V) any 
selected text; select text by dragging through it. To view another Verse (or Chorus, or Section), 
select it from the drop-down lists.

• When you’re finished, click OK. 

To place lyrics into the score (click assignment)

• Click the Lyrics Tool k. The Lyrics Menu appears.

• Choose Click Assignment from the Lyrics Menu. A box appears, containing the lyrics you 
created in the Edit Lyrics window. The bottom scroll bar scrolls through the syllables, left to 
right. The top scroll bar scrolls through the Verses, if there are more than one.

• If you want to place one syllable at a time, click the first melody note. You must click on 
the staff at the position of the note—not necessarily on the note itself. When you click, the first 
syllable displayed in the Click Assignment window disappears from the window and appears 
in the score, aligned with the note you clicked. Note: you must have the layer in which the 
notes are placed active for lyrics to be attached. Also, if you want to attach lyrics to notes in 
Voice two, hold down the shift key, then click on the note.

• If you want to assign all the lyrics at once, click the first melody note while pressing ctrl. 
This technique, called Control–Click-Assigning, tells Finale to assign each of the syllables, 
one after another, to consecutive melody notes, automatically skipping rests, tied notes, and 
notes in different layers and voices. If any syllables are assigned to the wrong notes, see “To 
correct misaligned lyrics.”
You have to repeat this process for each Verse, Chorus, or Section. If you have a second verse, 
for example, simply scroll back to its beginning spot, advance the upper scroll bar to Verse 2, 
and control–click-assign again.

To edit lyrics already in the score
The method described below is useful for making small changes to lyrics you’ve already placed in 
the score—correcting a misspelling, for example.

If the editing you need to do is more extensive, it may be easier just to do it directly in the Edit 
Lyrics window. After specifying the lyric type and number (by choosing Specify Current Lyric 
from the Lyrics Menu), choose Edit Lyrics from the Lyrics Menu. Any changes you make in the 
Edit Lyrics window automatically affect the lyrics in the score.

Note: If you have placed the same syllable on more than one note in your score, all instances of 
the syllable will be changed.

• Click the Lyrics Tool k. The Lyrics Menu appears.

• If you’re returning from other lyric editing, choose Type Into Score from the Lyrics 
Menu. Click on the staff at the position of the syllable you want to edit. The syllable is 
highlighted.
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• Type the new syllable. Anything you type replaces the highlighted syllable.
• Press the Space bar to advance to the next syllable. Press backspace to backspace over 

what you’ve just typed. To select any syllable, click within the staff lines; the syllable becomes 
highlighted, so that you can replace it with whatever you now type.

To correct misaligned lyrics
You may discover that your lyrics don’t “scan” after Control–Click-Assigning (that is, they don’t 
correspond correctly to the melodic notes). You may have entered too many syllables, failed to 
remember a melisma, or skipped a word. Using the following technique, you can shift all syllables 
by one note to the right from a selected point.

• Click the Lyrics Tool k, and choose Shift Lyrics from the Lyrics Menu. The Shift Syl-

lable dialog box appears, letting you specify the direction and range of the lyric shift you’re about 
to produce.

• From the drop-down list, choose the appropriate direction (Left or Right). These direc-
tions tell you which way Finale will shift lyrics relative to the melody.

• Click the appropriate range option. If you click Shift Syllables by One Note, to the End of 
the Lyric, Finale will shift every syllable from the one you click to the last one in the piece. If 
you click Shift Syllables by One Note, to the Next Open Note, the effect of your syllable-shift-
ing will “ripple through” the score only as far as the first note that doesn’t have a syllable 
attached to it. Subsequent syllables will remain where they are.
The Rotate syllables option is only useful if you’ve created a set of lyrics with more syllables 
than there are notes to attach them to. Click this option on those rare occasions when you want 
to replace the syllable on each note with the syllable to its right or left—but without changing 
which notes have lyrics (see the figure below).

If you select Rotate Syllables (and To The Right), you can click the first note of a melody (the first 
middle C, top) to shift the syllable assignments by one syllable to the left (bottom).

• Click OK (or press enter). You return to the score.
• If you specified a Right shift, click the note above the first syllable you want to move. The 

syllable at which you clicked, and subsequent syllables, shift to the right by one melody note, 
automatically skipping notes, rests, and tied notes. (You should click in the staff at the position 
of the note—not on the note itself.)

• If you specified a Left shift, click in the staff above the note just before the first syllable 
you want to move. The syllable on the following note, and subsequent syllables, shift to the 
left by one melody note, automatically skipping notes, rests, and tied notes.

&
c

œ œ

œ œ

Twin - kle twin - kle

œ œ
œ

lit - tle star

œ œ
œ œ

how I won- der

œ œ
œ

what you are.

Before

&
c

œ œ

œ œ

kle twin - kle lit -

œ œ
œ

tle star how

œ œ
œ œ

I won- der what

œ œ
œ

you are. Up

After



Lyrics 32-22      

OC

OC

ndex

Index

ext 
hapter

ext 
hapter

revious
hapter

revious
hapter
T

T

I

N
C

N
C

P
C

P
C

To correct overlapping lyrics
You’ll often discover that some of your lyric syllables overlap—or have more space than they 
need. You can use the Music Spacing command (which you normally use for respacing the notes 
in your music) to correct lyric collisions. See MUSIC SPACING for more information.

• Select the music you want to respace. In general, you’ll want to choose Select All from the 
Edit Menu, so that all staves are highlighted. (If you select only the lyric staff, for example, 
you could get unexpected spacing in other staves, because the Music Spacing command sets 
the measure widths for all staves according to the spacing of the selected region.)

• Choose Music Spacing Options from the Document Settings submenu of the Options 
Menu. The Music Spacing Options dialog box appears.

• Verify Lyrics is selected under Avoid Collision items. 

• Click the Mass Mover Tool l. 

• Choose either Apply Beat Spacing or Apply Note Spacing from the Music Spacing sub-
menu of the Mass Mover Menu. For a description of the differences between the two 
options, see MUSIC SPACING; they work equally well in correcting lyric overlaps.

This process takes time. When the Mass Mover truck cursor disappears, however, you’ll find 
that your music has been carefully respaced, with no lyric collisions.

To set the font for lyrics globally
This will set the default font for lyrics you are about to enter. It will not change the font for lyrics 
already entered in the score. See also CHANGE FONTS PLUG-IN.

• Choose Select Default Fonts from the Options Menu. The Select Default Fonts dialog box 
appears. See SELECT DEFAULT FONTS DIALOG BOX for more details.

• From the drop-down list for lyrics, select the lyric type you want to change (Verse, Cho-
rus, or Section). The Font dialog box appears.

• Select the type style you want for your lyrics. Under normal circumstances, Finale scales 
the type size of lyrics proportionally with the piece; if you reduce the music to half size (using 
the Resize Tool), the lyrics also shrink to half size.
If you’d prefer to specify a fixed size for the lyrics, so the text won’t vary with the size of the 
notes, select the Fixed Size checkbox.

• Click OK (or press enter) twice. Use this method to set the primary font for your lyrics. If 
there are occasional variations within this primary font, see “To change fonts within a lyric.”

To change fonts within a lyric
To set the primary font for a lyric, see “To set the font for lyrics globally.” Use this method for 
exceptions to the primary font.

• Click the Lyrics Tool k. The Lyric Menu appears. If you want to specify a particular lyric 

type or number, choose Specify Current Lyric from the Lyrics Menu.

• Choose Edit Lyrics from the Lyrics Menu. The text editor appears. If you have several lyric 
sections of the same type, use the drop-down lists to select the ones you want to change.

• Select the text whose font you want to change by dragging through it (so that it’s high-
lighted). 
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• From the Text Menu, select the desired font and click OK. 

• Click OK (or press enter) to return to the score. 

To prevent changing the type size for lyrics attached to cue notes
See “To set the font for lyrics globally.” See also CUE NOTES—To prevent attached lyrics and 
chord symbols from shrinking.

To set the baseline (vertical position) for lyrics numerically
You can set the height of the lyric line with respect to its staff either before or after you’ve placed 
your lyrics in the score. You can also set the baseline (on which the bases of the letters align) inde-
pendently for each staff in each system—and for each set of lyrics of each type. Finally, you can 
drag any syllable anywhere you want (see “To move or delete a syllable”).

• Click the Lyrics Tool k. The Lyrics Menu appears.

• Choose Adjust Baselines from the Lyrics Menu. The Adjust Baseline dialog box appears.
• Specify the lyric type and number for which you want to set the baselines. Also specify 

the staff and system number, if desired. You specify a staff and system number by clicking 
the Prev. and Next buttons beside the Staff and Staff System boxes. If you just want to move 
the baseline for the entire piece at once, you don’t need to adjust the staff or system controls; 
just click in the Piece text box.

• Enter the distance you want the baseline to be from the center line of the staff in the 
appropriate box or boxes. The center line of the staff is the zero position. The units are what-
ever you’ve selected using the Measurement Units command (Options Menu). 
For example, to set the baseline half an inch below the center line, you’d type –.5 (inches) in 
the Piece box. It’s a negative number because you’re moving the line down. If there were very 
low melody notes and you felt that the baseline in the third system needed to be a quarter inch 
lower still, you’d set the Staff System counter to 3 (by clicking the Next button twice), and 
you’d enter –.25 in the Staff System: 3 box. (If you ever want to restore all baselines to their 
original positions, click Set Piece Offsets to Default Font.)

• Click OK (or press enter). 

To set the baseline (vertical position) for lyrics graphically

• Click the Lyrics Tool k. The Lyrics Menu appears. Choose Specify Current Lyric from 

the Lyrics Menu to specify the lyric type and number, if you want.
• Choose Click Assignment or Type Into Score from the Lyrics Menu. Move the Click 

Assignment box out of the way, if necessary. At the left edge of the screen is a row of four 
small triangles pointing to the right. They control the baseline for the lyrics. If necessary, click 
the staff whose lyrics need adjustment.

• Drag the leftmost triangle up or down to set the baseline for the entire piece (for the 
selected lyric type and number). As you drag it, the other three triangles move with it.

• Drag the second triangle up or down to set the baseline for the selected staff only, all the 
way through the piece (for the selected lyric). As you drag this triangle, the two triangles to 
its right move with it.
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• Drag the third triangle up or down to set the baseline for this staff, this system only (for 
the selected lyric). As you drag this triangle, the rightmost triangle moves with it. Use this 
third triangle only in Page View (so you can see the system you’re affecting).

• Drag the rightmost triangle up or down to set the baseline for the next syllable, before 
it’s entered. This option is useful when you’re entering lyrics with the Type Into Score feature 
or by Click Assigning one syllable at a time.

To move or delete a syllable

• Click the Lyrics Tool k. The Lyrics Menu appears.

• Choose Adjust Syllables from the Lyrics Menu. 
• Click on the staff at the position of the syllable you want to move. Don’t click the syllable. 

Just click within the staff lines in line with the syllable you want to move or delete; its handle 
appears.

• Drag the handle to reposition the syllable. Select it and press the arrow keys to “nudge” 
it for fine positioning; select it and press delete to remove the syllable. Note that this 
method of deleting a syllable doesn’t pull the following syllables one note to the left; it allows 
you simply to remove a selected syllable, leaving all other syllables where they are. To delete 
a syllable where you want the remaining syllables to slide over to compensate, see “To correct 
misaligned lyrics.”

• To restore a syllable to its original position, click its handle and press backspace. 

To erase lyrics

• Click the Mass Mover Tool l and select a region. See SELECTING MUSIC for some 

region-selecting shortcuts. In any case, the Mass Mover Menu appears.

• Choose Clear Items from the Mass Mover Menu. The Clear Items dialog box appears.

• Proceeding through the dialog boxes, click Only Selected Items; Entries; Lyrics. 

• Click OK (or press enter) twice. 

To copy lyrics

• Click the Lyrics Tool k. The Lyrics Menu appears.

• Click the Mass Mover Tool l and select a region. See SELECTING MUSIC for some 

region-selecting shortcuts. In any case, the Mass Mover Menu appears.

• From the Mass Mover Menu, choose Copy Entry Items. The Entry Items dialog box 
appears.

• Check only the Lyrics box. Click OK.

• Drag the first selected measure so that it’s superimposed on the first target measure. If 
the first target measure isn’t on the screen, scroll to it, and then ctrl–shift-click it. In 
either case, the lyrics are copied from the source selection to the target music. Note that Finale 
will only place lyrics in the target region on notes that fall on the same beats as they did in the 
source region.
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Note: Do not use Insert or Replace Entries from the Edit Menu while copying lyrics. To avoid 
overwriting verses when pasting from the Clipboard, Finale will automatically place the cop-
ied lyrics in a new verse below existing verses.

To clone lyrics

• Click the Lyrics Tool k. The Lyrics Menu appears.

• Choose Clone Lyric from the Lyrics Menu. 

• Select the region whose lyrics you want to copy. You use the Lyrics Tool to select a musical 
region just as you would with the Mass Mover Tool: select one measure by clicking, addi-
tional measures by shift-clicking, a screenful by drag-enclosing, or an entire staff by clicking 
to the left of it.

• Drag the first selected measure so that it’s superimposed on the first target measure. If 
the first target measure isn’t on the screen, scroll to it, and then ctrl–shift-click it. In either 
case, the lyrics are copied from the source selection to the target music. Note that Finale will 
only place lyrics in the target region on notes that fall on the same beats as they did in the 
source region.

To change alignment and justification of syllables for individual notes

• Click the Lyrics Tool k. The Lyrics Menu appears.

• Choose Adjust Syllables from the Lyrics Menu. 

• Click on the staff at the position of the syllables in question. Don’t click the syllable; click 
in the staff lines. The syllables’ handles appear.

• Select the handle above the syllables.

• Choose from the Alignment submenu to change the position of the syllables relative to 
the notehead. See LYRICS MENU–ALIGNMENT AND JUSTIFICATION for more details.

• Choose from the Justification submenu to change the position of the syllables relative to 
each other. See LYRICS MENU–ALIGNMENT AND JUSTIFICATION for more details.

To set alignment and justification of syllables globally

• Click the Lyrics Tool k. The Lyrics Menu appears.

• Choose Lyric Options from the Lyrics Menu. The Lyric Options dialog box appears.

• If you would like specific alignment and justification settings for word extensions, select 
the Syllables with Word Extensions checkbox and set the alignment and justification set-
tings. For example, you could set the alignment and justification both to Left.

• If you would like specific alignment and justification settings for the first syllable in your 
score, select the First Syllable in Lyric checkbox and set the alignment and justification 
settings. For example, you could set the justification to Left and leave the alignment (relative 
to the note) to Center.

• If you would like specific alignment and justification settings for the first syllable of every 
system, select the Syllables at Start of System checkbox and set the alignment and justifi-
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cation settings. For example,  you could set the justification to Left and leave the alignment 
(relative to the note) to Center or set both the alignment and justification to Left.

• Select the alignment and justification settings for the remainder of the syllables in your 
score using Others. The order of the alignment and justification items in the dialog box also 
indicate order of precedence.  For example, if you have a syllable which is the first syllable in 
the system, but also has a word extension, the Syllables with Word Extensions settings will be 
used instead of the Syllables at Start of System (assuming you have both these items checked).

• Click OK. 

To draw a “word extension” underline
When a syllable’s note is tied over to another note or sustained through several notes (as in a mel-
isma), a common practice is to draw an underline following the syllable to indicate its extension.

It’s a good idea to wait until your piece is formatted and ready to print before adding word exten-
sions—and then to add them in Page View. That’s because word extensions don’t expand and con-
tract along with the music, so you should be sure that their lengths are appropriate for the piece in 
its final layout.

You can use the Word Extensions plug-in to add word extensions automatically in your score, or 
use the following process for any alternate positioning, or adding individual word extensions. See 
WORD EXTENSIONS PLUG-IN and WORD EXTENSIONS (REMOVE) PLUG-IN.

• Click the Lyrics Tool k. The Lyrics Menu appears. 

• Choose Edit Word Extensions from the Lyrics Menu. 
• Click near the syllable to be extended. A handle appears at the end of the syllable.
• Drag the syllable’s handle to the right. As you drag, you create an underline. To remove the 

underline, click its handle and press delete.
Hint: If a word extension straddles a system break, you may wonder how to draw its continua-
tion at the beginning of the next system, since there’s no syllable there from which to “launch” 
it. The solution: create an invisible syllable on the first note of the second system. To do so, 
choose Type Into Score from the Lyrics Menu and click the note to which you want to attach 
the invisible syllable, so that the blinking text cursor appears below the staff. While pressing 
alt, type 0160 on the numeric keypad, then release alt and type a regular space. Now choose 
Edit Word Extensions from the Lyrics Menu, and create the word extension from this invisible 
syllable as usual.

To adjust the position of “word extension” underlines
• Choose Lyric Options from the Lyrics Menu. The Lyric Options dialog box appears.
• Enter new values into the Word Extension Lift and Push boxes. The Word Extension Lift 

is the distance between the underline and the baseline (against which the bottoms of the lyric 
syllables align). The Word Extension Push is the distance between the end of the syllable and 
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the beginning of the underline. The units are whatever you’ve selected using the Measurement 
Units command (Options Menu). 

• Click OK (or press enter). 

Hymns
There are several conventions common to hymns which Finale can accommodate. For example, 
hymns are often notated on two staves (which may be Soprano/Alto and Tenor/Bass and double as 
an organ part), with lyrics in between. Use Layer 1/Layer 2 on each staff to create parts whose 
stems are automatically flipped the right way (see MULTIPLE VOICES).

Often, too, a hymn contains several verses, with a single repeated refrain. Assuming that the lyrics 
lie between the two staves, you need to adjust the space between the two staves so that there’s 
enough room for multiple verses, yet leave less space between staves where there are only the sin-
gle-line refrain lyrics.

The solution is to optimize the systems. In general, optimizing is used to suppress the printing of 
blank staves within a system. However, optimizing has another important effect: it allows each 
staff within a system to be independently movable in Page View.

Another characteristic of published hymns is that the first syllables of all verses are aligned with 
each other, flush left. (Lyrics under normal circumstances are centered under the notehead.) To 
create this alignment, see LYRICS OPTIONS DIALOG BOX.

To create variable-distance systems
For best results, perform this operation last, just before you print. See OPTIMIZING SYSTEMS for 
more information.

• Click the Page Layout Tool f.

• Select the systems or choose Select All from the Edit Menu.
• From the Page Layout Menu, choose Systems, then Allow Individual Staff Spacing.

• Click the Staff Tool s; then drag the lower handle of any staff to move it. 

Hyphens
A hyphen (or a space), when typed into the Edit Lyrics window for lyrics, indicates the end of a 
lyric syllable. When Finale distributes lyrics automatically into the score (see LYRICS), it looks for 
a hyphen or space as its cue to advance to the next melody note.

To prevent a hyphen from ending a syllable
In certain situations (melismatic passages, for example), you may not want Finale to assume that a 
hyphen is the end of a syllable.

• If you’re not already in the Edit Lyrics window, click the Lyrics Tool k and choose 

Edit Lyrics from the Lyrics Menu. The Edit Lyrics window appears.
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• To create a hyphenated word, all of which will be assigned to a single note, type 0173 on 
the numeric keypad while pressing the alt key in place of the normal hyphen. When these 
lyrics are Click-Assigned into the score, the alt+0173 hyphen will not separate the word into 
syllables.

To continue a hyphen across systems
Finale can’t automatically wrap a hyphenated word across systems; however, you can simulate the 
effect. After you have completed your layout, follow the instructions below to add two invisible 
syllables with a hyphen between them. You can then Click-Assign the first half to the first syllable 
of the system and the second half to the same syllable as your hyphenated word. Finale will create 
hyphens between the two invisible syllables.

• If you’re not already in the Edit Lyrics window, click the Lyrics Tool k and choose 

Edit Lyrics from the Lyrics Menu. The Edit Lyrics window appears. You may wish to place 
your “special” lyrics in a separate verse or chorus.

• Click at the end of your lyrics and type alt+0160 then a hyphen, then another invisible 
syllable - alt+0160. Click OK to exit the Edit Lyrics window.

• From the Lyrics Menu, choose Click Assign. The Click Assignment window appears.

• Scroll through the lyrics until you find your hyphen, then click back one.

• Click on the first note of the system. The invisible syllable is assigned to your note.

• Click on the same note as your hyphenated word. The second invisible syllable is assigned 
to your note, creating hyphens from the system start.

Melisma
See also SLURS; VOCAL MUSIC—To beam according to lyric syllables.

A melisma is a series of notes sung on the same lyric syllable. When Finale assigns lyric syllables 
to a melody, it has no way of knowing which melody notes are melismatic. Therefore, when 
you’re creating lyrics (if you plan to have Finale assign them to notes automatically), you can 
anticipate the melismatic passages by creating an invisible syllable for each note of the melisma.

To create invisible syllables when typing lyrics

• Click the Lyrics Tool k. The Lyrics Menu appears.

• Choose Edit Lyrics from the Lyrics Menu. The Edit Text window appears. Type the lyrics in 
the usual way, up to the melisma.

• Type the syllable to be sustained, followed by the usual space or hyphen. For each subse-
quent note of the melisma, type alt+0160, space. Finale considers each alt-0160 (press alt 
while typing 0160) a syllable. Therefore, you need to separate it as you would any syllable—
with a space or a hyphen. Thus you type an alt-0160 followed by a regular space (or a hyphen) 
for each subsequent note of the melisma. Complete the remaining lyrics.

• Click OK. When you enter these lyrics using the Control–Click Assignment method (see 
LYRICS), Finale distributes the invisible melismatic syllables you just created to the corre-
sponding notes of the melody.
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To shift lyrics to the right or left
If you failed to anticipate the melisma (by typing alt-0160 characters, as described above) when 
entering the lyrics in the Edit Lyrics window, you can adjust misaligned lyrics by using the Shift 
Lyrics command. For full instructions, see LYRICS—To correct misaligned lyrics.

To draw a “word extension” underline
When a syllable’s note is tied or sustained through to another note, a common practice is to draw 
an underline following the syllable to indicate its suspension. See LYRICS—To draw a “word 
extension” underline. See also LYRICS—To adjust the position of “word extension” underlines.

Some musicians prefer to draw multiple hyphens between syllables that are far apart. In such 
cases, you can draw in a dashed line; see DASHED LINES.

Vocal music
See also CHORAL MUSIC; HYMNS; LYRICS.

One convention used in opera or art song notation is beaming to lyrics. In this practice, eighth 
notes and sixteenth notes are never beamed together in the vocal line except when a syllable is 
sustained through more than one note (as in a melisma).

To beam according to lyric syllables

• Click the Mass Mover Tool l and select a region. See SELECTING MUSIC for some 

region-selecting shortcuts.

• From the Rebeam submenu of the Mass Mover Menu, choose Rebeam to Lyrics. The 
Rebeam to Lyrics dialog box appears.

• Specify the type of lyric you want rebeamed. You can specify an individual Verse, Chorus, 
or Section, if you wish, by selecting the lyric type, and entering the Verse, Chorus, or Section 
number.

• If you want beams broken at each beat, click Also Break Beams at Each Beat in the Time 
Signature. In other words, Finale will begin a new beam at each beat even if a lyric melisma 
is still continuing. If you don’t use this option, the melisma beam will continue all the way 
through the measure—as long as the melisma lasts.

• Click OK. 
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Choral music
See also HYMNS; LYRICS.

There are no specific instructions for working with choral scores, only a few tips.

Work from a template (a blank, preformatted document)—either one of the Choral Score Tem-
plates (in your Templates folder) or one of your own design. This way, you’ll save yourself the 
trouble of reconstructing the system each time you create a new document with the same format.

To enter choral music quickly, such as SATB (soprano, alto, tenor bass) parts: Use the Speedy 
Entry Tool (see SPEEDY ENTRY or RECORDING WITH HYPERSCRIBE) to create the music as a series 
of four-note chords on one staff. Then use Finale’s Explode Music command to strip the chordal 
passage into four separate one-line staves. See EXPLODING MUSIC for instructions.

If the choir sings a section of homophonic music—where all voices sing the same rhythms and 
same words—use the Clone Lyric command in the Lyrics Menu to copy lyrics from one line to 
another. This way, if you need to change a lyric, you only have to edit it once (in a single Edit Lyr-
ics window) and the change will ripple through all vocal parts.

For setting alignment and justification of syllables with word extensions throughout the document 
see LYRIC OPTIONS DIALOG BOX.

The tenor part is often notated an octave higher than it sounds. Use the Staff Attributes Tool to 
make the tenor staff a transposing part (see TRANSPOSING INSTRUMENTS) or use the Treble 8vb 
clef for that staff (see CLEFS).

Remember the Piano Reduction plug-in if you want to create a piano reduction. See PIANO 
REDUCTION PLUG-IN.)

Elisions
An elision is when two or more syllables are sung under the same note, such as in a folk song, 
chant or foreign language. Because Finale will advance to the next note if you enter a space, 
you’ll need to add an invisible syllable or hard space between the two real syllables. You can also 
use this method to place verse numbers with the first syllable. If you prefer a slur instead of a 
space between the syllables, see TO CREATE AN ELISION SLUR BETWEEN LYRICS.

To create invisible syllables when typing lyrics

• Click the Lyrics Tool k. The Lyrics Menu appears.

• From the Lyrics Menu, choose Edit Lyrics. The Edit Text window appears. If you prefer, 
choose Type into Score. Type the lyrics in the usual way, up to the elision.

• Type the first syllable. Next type alt+0160.To type an alt character, hold down the alt key, 
and while holding it down, type 0160 on the calculator keypad on the side of your computer 
keyboard. Finale inserts a hard space. Continue by typing the next syllable, which will be 
attached to the syllable before it. Complete the remaining lyrics.

• Click OK. When you enter these lyrics using the Control–Click Assignment method (see 
LYRICS), Finale distributes the syllables you just created to the corresponding notes of the 
melody, but treats the elision as a single syllable.
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To create an elision slur between lyrics

• Click the Lyrics Tool k. The Lyrics Menu appears.

• From the Lyrics Menu, choose Edit Lyrics. The Edit Text window appears. Type the lyrics 
in the usual way, up to the elision.

• Type the first syllable. Without adding a space, type a capital I, then the second syllable. 
• Drag to select the I. From the Text Menu, choose Font. Choose EngraverFontSet then 

click OK. Complete the remaining lyrics.
• Click OK. When you enter these lyrics using the Control–Click Assignment method (see 

LYRICS), Finale distributes the syllables you just created to the corresponding notes of the 
melody, but treats the elision as a single syllable. A slur will appear between the two syllables.
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